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Overview

Stellar Merge PST is an easy to use application designed to merge multiple Outlook PST files into a
single file without modifying contents of the original Outlook PST files. This software can be used to
merge Email, Calendars, Contacts, Journal, Notes, To-Do and Tasks folders from different PST files
created in different Outlook versions. PST files can be joined, creating multiple folder hierarchies within
one PST file, or they can be merged where matching folders are combined within a new or into an
existing PST file. The user can also merge only specified data from the PST file such as, Calendars,

Contacts or any other folder from the specified PST file without the need to merge all PST files.

The software supports removing the duplicate items and excluding deleted items from new PST file

during the merging process.

Key Features

Merge and Join multiple outlook files.

¢ Provides Merge and Join PST saving options (New PST, Existing PST, Outlook Profile, Office
365, Exchange Server).

e Maintains the integrity of the original PST files while merging them.

¢ Allows saving the new PST file at user defined location.

e Supports password protected PST files.

e Option to exclude Duplicate Items while merging PST files.

e Option to Exclude Deleted Items and Junk Items.

e Supports MS Outlook 2003, 2007, 2010, 2013, 2016.

e Compatible with Windows 7, Windows 8, Windows 8.1 and Windows 10.
e Option to Drag and Drop PST files.

¢ Filter items to provide more space.



Installation Procedure

Before installing the software, check that your system meets the minimum system requirements:

Minimum System Requirements:

Processor: Pentium Class

Operating System: Windows 10/8.1/8/7 / Vista / Windows Server 12 / Windows Server 8
Memory: Minimum 1 GB

Hard Disk: 50 MB of Free Space

MS Outlook: 2016, 2013, 2010, 2007, 2003 / Office 365

To install the software, follow these steps:

Double-click StellarMergePST.exe executable file to start installation. Setup- Stellar Merge PST

dialog box is displayed.
Click Next. License Agreement dialog box is displayed.

Choose | accept the agreement option. Next button will be enabled. Click Next. Select

Destination Location dialog box is displayed.

Click Browse to select the destination path where the setup files will be stored. Click Next. Select

Start Menu Folder dialog box is displayed.

Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog

box is displayed.
Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed.

Review the entries. Click Back if you want to change them. Click Install to start installation. The

Installing window shows the installation process.

After completing the process, Completing the Stellar Merge PST Setup Wizard window is
displayed. Click Finish.

Note: Clear Launch Stellar Merge PST check box before clicking Finish to prevent the software from

launching.



Launching the Software

To launch Stellar Merge PST in Windows 10:

e Click Start icon -> All apps -> Stellar Merge PST -> Stellar Merge PST Oir,
e Double click Stellar Merge PST icon on the desktop. Or,
e Click Stellar Merge PST tile on the home screen.
To launch Stellar Merge PST in Windows 8.1/ 8:
e Click Stellar Merge PST tile on the home screen. Or,
o Double click Stellar Merge PST icon on the desktop.
To launch Stellar Merge PST in Windows 7 / Vista:
e Click Start -> Programs -> Stellar Merge PST -> Stellar Merge PST. Or,
e Double click Stellar Merge PST icon on the desktop. Or,

e Click Stellar Merge PST icon in Quick Launch.



User Interface

Stellar Merge PST software has a very easy to use Graphical User Interface. The user interface contains
features required for merging/ joining Outlook PST files.

After launching the program, you will see the main user interface as shown below:
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Drag & Drop
to add PST

The user interface contains Menus and Buttons that let you access various features of the software with

ease.



Menus

Home Menu
5 Stellar Metge PST Home
HOME LOGS REGISTRATION SUPPORT HELP Use thlS
/ﬁ\ BB ’ ; : option to
e s e > go to the
Home Exclude tems Default Duphicate Critena Advanced Duplicate Criteria home

screen of
the
software.
Add PST
Use this
option to
add the
PST files
which you
want to
merge.
Find PST
Use this
option to
search
PST files
from the
system.
Merge
PST
Use this
option to
merge all
folders of

selected



PST files
in a new or
existing
PST file.

Join PST

Use this
option to
join  PST
files by
creating
new folder
for each
selected
PST file.

Stop

Use this
option to
stop the
merge

process.

Exclude
Deleted
Folder

Click this
option to
exclude
deleted

items.

Exclude
Junk
Folder

Click this
option to

exclude



junk email
folder.

Remove

Duplicate

Click this
option to
remove
the
duplicate
items from
a PST file
during
merging

process.

Subject:
Two mails
will be
regarded
as
duplicate if
their
subject is
same. This
is checked

by default.

Sender
Email:
Two mails
will be
regarded
as
duplicate if
they are
sent by
same
Email ID.



This is
checked

by default.

Text: Two
mails will
be
regarded
as
duplicate if
their
content is
same. This
is checked

by default.

Sender
Name:
Two mails
will be
regarded
as
duplicate if
their
sender
name is

same.

Recipient
Name:
Two mails
will be
regarded
as
duplicate if
their
receiver
name is

same.



Logs Menu

Internet
Header:
Two mails
will be
regarded
as
duplicate if
their
internet
header is

same.

Attachme
nt Files:
Two mails
will be
regarded
as
duplicate if
they have
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attachmen
t.

Date and
Time of
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Two mails
will be
regarded
as
duplicate if
their date
and time
of sending

is same.



HOME LOHGS REGISTRATION SUPPORT

Logs

Registration Menu

HOME LOGS REGISTRATION SUPPORT
Register
Registratior
Support Menu
HOME LGS REGISTRATION SUPPORT
¥ = ]
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Update Purchate Support Submit
Enguiry
Support

HELF

HELP

HELP

Log Report

Use this option to view / save the

log report.

Register

Use this option to register the

software after purchasing.
Transfer License

Use this option to transfer the
license of the registered software to

another computer.

Update

Use this option to check for both,
latest minor and major versions

available online.

Purchase

Use this option to buy Stellar Merge
PST.

Support

Use this option view the support

page of stellarinfo.com

Submit Enquiry

Use this option to submit enquiry to


http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php

Help Menu
L |
HOME LGS REGISTRATION SUPPORT
R s e
Help Knowledgebaie Abaut
Help
Style Menu

# Style T
Office 2013 White Theme
Office 2013 Light Gray Theme
Office 2013 Dark Gray Theme

Office 2016 Colorful Theme
Office 2016 Dark Gray Theme
*  (Office 2016 White Theme

HELP

stellarinfo.com

Help

Use this option to view the help

manual for the software.
Knowledgebase

Use this option to visit

Knowledgebase articles of
stellarinfo.com

About

Use this option to read information

about the software.

Style

Use this option to switch between
various themes for the software, as
per your choice.


http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/

Buttons

//ﬁ\ Click this button to go to the Home screen of the software.
Home
Click this button to add the PST files which you want to merge.
Add
PsT
E Click this button to search PST files from the system.
Find
PsT
E Click this button to merge all folders of selected PST files in a new or existing PST
Merge file.
PsT
E Click this button to join PST files by creating new folder for each selected PST file.
lain
PsT
h'd Click this button to stop the merge process.
Stop

Click this button to view / save the log report.

Log
Report
» Click this button to register the software after purchasing.
Register
K Click this button to transfer the license of the registered software to another

Tramsfer computer.
Liceanse
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Enowledgebase

About

Click this button to check for both, latest minor and major versions available online.

Click this button to buy Stellar Merge PST software.

Click this button to view the support page of stellarinfo.com.

Click this button to submit enquiry to stellarinfo.com.

Click this button to view the help manual for the software.

Click this button to visit Knowledgebase articles of stellarinfo.com.

Click this button to read information about the software.


http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php

Ordering the Software

Click http://www.stellarinfo.com/merge-outlook-pst-files.php to know more about Stellar Merge PST.

To purchase the software online, please visit http://www.stellarinfo.com/email-utilities/merge-outlook-pst-
files/buy-now.php

Alternatively, click on Purchase icon in Support Menu on Menu Bar to purchase the software online.
Select either of the methods given above to purchase the software.

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required
to activate the software.


http://www.stellarinfo.com/merge-outlook-pst-files.php
http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php
http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php

Registering the Software

The demo version is just for evaluation purpose and must be eventually registered to use the full
functionality of the software. The software can be registered using the Registration Key which you will

receive via email after purchasing the software.

Note: In demo version of the software, you will be able to see mail body and attachments only. Fields
such as From, To, CC, BCC, and Subject display 'Demo'. To view complete mailbox, you need to
purchase and register the software.

To register the software:

1. Run demo version of Stellar Merge PST software.

2. On Registration menu, click Register option. Register window is displayed as shown below.

Register x

Registration Option
To complete the regisiration process, select one of the oplions given below:

| dont have the registration key

| hawve the registration key

. OK Cancel

3. Choose 'l don’t have the registration key’ (Use this option if you have not purchased the product)

or select’] have the reqistration key’ (Use this option if you have already purchased the product).

To register the software, when you do not have aregistration key, follow the steps given below:

1. In the Register window, select 'l don't have the registration key' option. Click OK, to go online
and purchase the product.

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of

purchase.

3. In the Online Registration window, type the Registration Key and click Register button (Please

ensure that you have an active Internet connection).



Omnlime Registration 4

Enter the: Registration Key and dlick the ‘Register’ button. The pragram
automatically connects to the server to register the product.

Registration Key: | OB B0 00D 00 Flegister

Mote: Please ensure you have a warking intemet conmection for online activation,

Where is my registration key?
The regstration key has been sent bo you through emal by our payment gateway,
after successiul purchase of software
Registration key is sent 1o the same emai id, which you specified in your purchase
details

Cancel

4. ' Activation Completed Successfully ' message is displayed after the process is completed

successfully. Click OK.

To register the software, when you have a key, follow the steps given below:

1. Inthe Register window, select 'l have the registration key' option.

2. You can choose either 'Online Registration' (Use this option to register the software over Internet)

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for

any reason, Internet connection is unavailable).

e Online Registration
Online Registration is possible only when an active Internet connection is available.

o To register the software online:

1. From the Register window, select Online Registration. Click OK.

Register =
Registration Option
To complete the regisiration process, select one of the options given below:
| don't hawe the registration key
(I have the registration key;
+ Oniling Registration Offine Registration

2. An Online Registration dialog box will appear.



3. Type the Registration Key (received through email after purchasing the product) in the
field of Registration Key. Click Register.

Omnlime Registration 4

Enter the Registration Key and click the 'Register’ button. The program
automatically connects to the server to register the product.

Registration Key: | 3000200003000 300000000 Reqister

Mote: Please ensure you have a warking intemet conmection for online activation,

Where is my registration key?
The registration key has been sant to you through email by our payment gateway,
after successiul purchase of software
Registration key is sent 1o the same emal id, which you specified in your purchase
details

Cancel

4. The software would automatically communicate with the license server to verify the
entered key. If the key you entered is valid, software will be registered successfully.
e Offline Registration

Offline Registration enables you to register the product when your computer does not have an Internet

connection.

o To register the software offline:

1. From the Register window, select Offline Registration. Click OK.

Register x
Registration Option
To complete the regisiration process, select one of the options given below;

| don't have the registration key

# | have the registration key
Online Registration = i#fine Registration|

2. An Offline Registration dialog box will appear displaying Registration ID in its

respective field.



Offline Registration x

You need to send below isted ‘Registration |0V to Stellar Technical Support to
get your License Key'.

if you have already received your ‘Licenss Fey'. enterit and click ‘Register’
button to register the product,

Regigtration 1D; | CK-AYYLDQDXWSYUCUPA-1GOVWWEL58GG1722-5109

License Kay:

Cancel I Register

3. To get your License Key, which is required to register the software manually, you need to
mail the listed Registration ID to support@stellarinfo.com.

4. A License Key will be sent to your email address after verifying the Registration ID and
purchase details by Stellar Technical Support.

5. After receiving the License Key, open Stellar Merge PST. In Register window, select 'l

have the registration key'.
6. Select Offline Registration and click OK.

7. Enter the License Key received through email in the field of License Key.

Offline Registration 4

You need to send below isted ‘Registration |0V to Stellar Technical Support to
get your License Key'.

if you have already received your ‘Licenss Fey'. enterit and click ‘Register’
button to register the product,

Regigtration ID;  CH-AYYLDQDXWSYUCUPA-1GOVWWEL58GG1722-5109

License Key: LEREEEEEEEEEEEREERER R LR

Cancel I Register

8. Click Register to activate the software. A confirmation message is displayed if a valid key
is entered. Click OK.


mailto:support@stellarinfo.com

Transfer License

Stellar Merge PST allows you to transfer the license of the registered software to another computer on
which you want to run the software with full functionality. This operation deactivates the product on your

current computer so it can be reactivated on the new computer.

To transfer a software license from one computer to another, please follow the specific steps
below:

On Target Computer:

1. Run demo version of the software.
2. In Registration Menu on Menu Bar, click Register. A new dialog appears.
3. From the Register window, select Offline Registration. Click OK.

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field.

Offline Registration x

You need to send below isted ‘Registration |0V to Stellar Technical Support to
get your Licensa Key'.

if vou have already received your ‘License Key'. enter it and click "Register’
button to register the product

Registration ID: | *CK-AYYLDQIXWSYUCUPA-1GOVWWEL58GGIT22-5109

License Kay:

Cancel Register

On Source Computer:

1. Run registered version of Stellar Merge PST software.

2. In Registration Menu on Menu Bar, click Transfer License.



Transfer License x

To transfer the license of the program copy the Registration 10 from the: tanget
computer and paste it below Click on “Transfer In™ to generate a License key
which needs to be pasted in tanget computer.

Registration 10:
Licerse Key:
dlick here to know the steps of transferring license to another computer.

Save To File Transfer In Cancel

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the
Source Computer.

4. To get your License Key, click Transfer In button on Source Computer. This will generate a
License Key.

Transfer License x

T transfer the license of the program copy the Regestration 1D from the tanget
computer and paste it below Click on “Transfer In™ to generate a License key
which needs to be pasted in target computer.

Reqgistration |0 FCK-7YBRCBORLEEVEHLE-0GY OFHCCLPYBAIOD- 1414
License Key: [ 3000000000ODENNNDOONDA00DN
dick here to know the steps of transfierring license to snother computer.

Save To File Transfer In Cancel

5. You can also save the License Key generated on the source computer. Click Save to File button
to save the Registration ID and the License Key. In Browse for Folder dialog box, select the
location where you want to save the details. Click OK.

6. ' License Key has been saved successfully ' message is displayed after the saving process is
completed successfully. Click OK.

This will deactivate the product on Source Computer and you will no longer be able to use the software
anymore on this computer.

On Target Computer:

1. Type the License Key which you have generated on the Source Computer in the provided field of
License Key.



Offline Registration x

You need to send below isted ‘Registration |0V to Stellar Technical Support to
get your License Key'.

if wou have already received your ‘Licenss Fey'. enterit and click ‘Register’
button to register the product,

Regigtration ID;  CH-AYYLDQIXWSYUCUPA-1GOVWWEL58GG1722-5109

License Key: PEERE R RS REE R R e R

Cancel I Register

Click Register to complete the activation process.

' Activation Completed Successfully ' message is displayed after the process is completed

successfully. Click OK.



Updating the Software

Stellar releases periodical software updates for Stellar Merge PST software. You can update the
software to keep it up-to-date. These updates can add a new functionality, feature, service, or any other
information that can improve the software. Update option of the application is capable of checking for
latest updates. This will check for both latest minor and major versions available online. You can easily
download minor version through the update wizard. However, the major version, if available, has to be
purchased. While updating the software, it's recommended to close all the running programs. Note that

demo version of the software cannot be updated.
To update Stellar Merge PST:
¢ Click Update icon from Support Menu.

e Stellar Update Wizard window opens. Click Next. The wizard will search for latest updates, and if

it finds any new updates, a window will pop up indicating its availability.

e Click Next and the software will download the files from the update server. When the process is

complete, the software will upgrade to the latest version.
Live Update may not happen due to following reasons:
e Internet connection failure
e Updates are not available
e Unable to download configuration files
e Unable to locate updated files or version
e Unable to locate executable file

Note: If a major version is available, you need to purchase the software in order to upgrade it.



Stellar Support

Our Technical Support professionals will give solutions for all your queries related to Stellar products.

You can either call us or go online to our support section at http://www.stellarinfo.com/support/

For price details and to place the order, click http://www.stellarinfo.com/email-utilities/merge-outlook-pst-

files/buy-now.php

Chat Live with an Online technician at http://www.stellarinfo.com/

Search in our extensive Knowledge Base at http://www.stellarinfo.com/support/kb/

Submit enquiry at http://www.stellarinfo.com/support/enquiry.php

Send e-mail to Stellar Support at support@stellarinfo.com

Support Helpline

Monday to Friday [ 24 Hrs. a day ]

USA (Tollfree- Pre Sales Queries)

+1-877-778-6087

USA (Post Sales Queries)

+1-732-584-2700

UK (Europe)

+44-203-026-5337

Australia & Asia Pacific

+61-280-149-899

Netherlands Pre & Post Sales Support

+31-208-111-188

Worldwide

+91-124-432-6777

Email Orders

orders@stellarinfo.com



http://www.stellarinfo.com/support/
http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php
http://www.stellarinfo.com/email-utilities/merge-outlook-pst-files/buy-now.php
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/kb/
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com
mailto:orders@stellarinfo.com

Add PST Files

To start the merge process, you need to add files to the Stellar Merge PST software. You can add a

single file or multiple files to the software.

To add PST files:
¢ Run Stellar Merge PST.

e From the Home menu, click Add PST icon. Open dialog box will appear. Browse and select the
desired file and then click Open.

.Zﬁt-!.a -

+

Drag & Drop
to add PST

Or,
e Click Drag & Drop to add PST button on the main interface. An Open dialog appears, choose
the location from where you want to select the file. Click Open button.
Or,
¢ Open Windows Explorer to Drag & Drop the desired file(s) to the application.



Find PST Files

Stellar Merge PST allows you to find PST files in your computer's hard drive, in case you don't know their
location. With the help of 'Find PST' option, you can find PST files in any folder, subfolder or an entire

volume in your system.

To Find a PST File:

Run Stellar Merge PST application.

From the Home Menu, click Find PST.

In Browse for Folder dialog box, select the drive or folder you want to search for PST files. Click

OK.

After the search is finished, a list of PST files found in the selected drive or folder is shown.
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wish to merge from this list and click Next button to proceed to the merging



Saving Options

Stellar Merge PST software provides you with merge/join saving options where PST files can be joined,
creating multiple folder hierarchies within one PST file, or they can be merged where matching folders are

combined within a new or into an existing PST file.
Merge PST Files

Merge PST option allows to merge all folders of selected PST files in a new PST file. The different

merging options are described below:
e Merge to new PST File
¢ Merge to existing PST File
e Merge to Outlook Profile
e Merge to Office 365

¢ Merge to Exchange Server

Saving Options

| Merge PST
Merge to new P3ST File Merge to Office 365
Merge to existing PST File Merge to Exchange Jerver

Merge to Outlook Profile

Join PST  {Add each PST file 25 separate folder structure)

Select destination to save PST :
C:\Users\Administrator. TS-D 10'Desktop Browse



Join PST Files

Join PST option allows you to join PST files by generating multiple root folders to accommodate new

child folders from separate PST files. The different joining options are described below:
e Join to new PST File
e Join to existing PST File
e Join to Outlook Profile
¢ Join to Office 365

¢ Join to Exchange Server

Saving Options

Merge PST

7| Join PST  [Add each PST file as separate folder structuns)

#) Joar to mew PST File Joir to Office: 365

Joir to existing PST He Joir to Exchange Server

Jain to Outlook. Profie

Select destination to save PST :
C:\Users\Administrator. T5-D 10'Desktop Browss



Merge PST Files

Stellar Merge PST allows you to merge similar folders of selected PST files into a single PST file. It
creates a new output PST file without making any changes into the original data or folder of an existing

PST. With this application, users can use the option to include or exclude Deleted/Junk Iltems folder from
an Outlook PST file.

To Merge PST Files:

1. Add PST Files which you want to merge.

2. Stellar Merge PST application window shows a three-pane window. All folders with number of

items in them will be listed in the left-pane, under the root node. Click on a folder to view its
content in the middle pane.
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3. From the root node, select the folders which you want to merge. Make a check on the root node
to automatically select complete mailbox / all the folders.

4. From the Home menu, select desired options from Exclude Items, Default Duplicate Criteria
and/or Advanced Duplicate Criteria to remove duplicate items.

O Advanced Duplicate Criteria is enabled only when you select Default Duplicate Criteria.

5. From Saving Options section in the right pane of the screen, select the desired option.



e Merge to new PST File: You can select this option when you want to merge contents into a
new PST file.

o Select Merge to new PST File option.

o Click Browse and select the location where you want to save the PST file. Click OK.

Saving Dplions
| Mage PST
Merge to new PST Fie Merge 1o Office 385
Marge to esxdsting P5T File Merge 1o Exchange Sarver

Marge to Outlock: Profile

Jon PST  (Add each PST file a2 separate folder struchure)

Select destination to save ST

Cosers \Admirestrator . T5-D 10 \Desctop Tre—

o Click Merge. 'Process completed' message is displayed after the process is
completed successfully. Click OK. The PST file will be saved at your specified

location.

o Merge to existing PST File: You can select this option when you want to merge contents

into an already existing PST file.

o Select Merge to existing PST File option.

o Click Browse and locate the PST file into which you want to merge. Click Open.



Saving Dplions

| Marge PS5T
Merge to new PST Fie Merge 1o Office 385
*) Merge to edsting PST File Merge 1o Exchange Sarver

Marge to Outlock: Profile

Jon PST  (Add each PST file a2 separate folder struchure)

Seleck PST file
Cr'sers \Administrator. T5-D 10Degkctop \Stellar Outiook . pst Brenwse

o Click Merge. 'Process completed' message is displayed after the process is
completed successfully. Click OK. The PST file will be saved at your specified

location.

Merge to Outlook Profile: You can select this option when you want to merge contents into

an Outlook profile.

o Select Merge to Outlook Profile option.

o Select the desired Outlook Profile.



Saving Options

| Marga FST

Merge to new PST Fle Merge to Office 365
Mearge to edsting F5T File Marge to Exchange Server
Merge to Dutiook Profie
Join PST  (Add each P5ST file as separate folder structure)
Owlook profile Outasnk -

o Click Merge. 'Process completed' message is displayed after the process is
completed successfully. Click OK. The PST file will be saved at your specified

location.

Note: In case of Merge to new PST File, Merge to existing PST File and Merge to Outlook Profile, if
the size of the merged PST file exceeds the MS Outlook file size limit then the contents of merged PST

file will split accordingly.

e Merge to Office 365 : You can select this option when you want to merge contents into
Office 365 profile.

o Select Merge to Office 365 option.
o Login by entering the Office 365 ID and Password.

Note: Make sure you have entered correct Office 365 ID and Password.



Saving Dplions

| Mage PST
Merge to new PST Fie Merge 1o Office 385
Marge to esxdsting P5T File Merge 1o Exchange Sarver

Marge to Outlock: Profile

Jon PST  (Add each PST file a2 separate folder struchure)

Conneaction Option

Office 365 1D sample Ssoftwarevisiblity, com

Passweord SEREEEREEERE

o Click Merge. 'Process completed' message is

displayed after the process is

completed successfully. Click OK. The PST file will be saved at your specified

location.

Merge to Exchange Server: You can select this option when you want to merge the

mailboxes on Exchange Server.

o Select Merge to Exchange Server option.

o From Exchange Connection Option select (either Administrator Domain or User

Domain) and then enter Microsoft Exchange Server Information details.

o Enter Admin Email ID, Password, Mailbox Email Id and Server Name (for MS
Exchange 2007, 2010, 2013, 2016) and check the checkbox for Exchange Server

2010 or higher.



Exchange Cormection Option

# Admirigtrator Domain

Uiser Domain
Aderins Email 1D adminisirator @example.com
Password: BEERREERRES
Mailbooc Email 10: john@example.com
Server Mame; PC10

[ M5 Exchange Server 2010 or higher

ok [ caes

If you have selected User Domain option, then enter Mailbox Email ID, Password,
Mailbox Name and Server Name. Click OK button.

Note: Make sure you have entered correct MS Exchange Server details.

Exchange Connection Option
Admirigtrator Domain %) User Domain
Mailbes Email ([D: | Jonn@example. com
Password: EEEEEEREREE
Mailboo: Name: John Richards
Server Name: PC10

[ M5 Exchange Server 2010 or igher

[_ox ][ Cones

o Click Merge. 'Process completed' message is displayed after the process is

completed successfully. Click OK. The PST file will be saved at your specified
location.



Join PST Files

Stellar Merge PST allows you to join PST files by generating multiple root folders to accommodate new
child folders from separate PST files. It creates a new Outlook PST file without making any changes into
the original data or folder of an existing PST. With this application, users can use the option to
include/exclude Deleted and Junk Items folder from an Outlook PST file.

To Join PST Files:

1. Add PST Files which you want to join.

2. Stellar Merge PST application window shows a three-pane window. All folders with number of
items in them will be listed in the left-pane, under the root node. Click on a folder to view its
content in the middle pane.
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3. From the root node, select the folders which you want to join. Make a check on the root node to
automatically select complete mailbox / all the folders.

4. From the Home menu, select desired options from Exclude Items.

O In case of Join PST, Advanced Duplicate Criteria and Default Duplicate Criteria both are

disabled.

5. From Saving Options section in the right pane of the screen, select the desired option.
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Saving Oploas



Join to new PST File: You can select this option when you want to join contents into a new
PST file.

o Select Join to new PST File option.

o Click Browse and select the location where you want to save the PST file. Click OK.

Saving Dplions
Marge PST
#Join PST  (Add each PST file a3 separate folder structure)
Join o nesw PST File Join to Office 365
i fo exdsting PET Fi= Join to in'.'-!n;g Seroer
Join to Outleok: Profile
Select destination to save PST
Cosers \Admirestrator . T5-D 10 \Desctop Tre—

o Click Join. 'Process completed' message is displayed after the process is completed

successfully. Click OK. The PST file will be saved at your specified location.

Join to existing PST File: You can select this option when you want to join contents into an

already existing PST file.

o Select Join to existing PST File option.

o Click Browse and locate the PST file into which you want to join. Click Open.



Saving Dplions

Marge PST
#Join PST  (Add each PST file a3 separate folder structure)
Join o nesw PST File Join to Office 365
Join to eadsting PST Fie Join to Exchangs Server

Join to Outleok: Profile

Seleck PST file
Cr'sers \Administrator. T5-D 10Degkctop \Stellar Outiook . pst Brenwse

o Click Join. 'Process completed' message is displayed after the process is completed

successfully. Click OK. The PST file will be saved at your specified location.

o Join to Outlook Profile: You can select this option when you want to join contents into an

Outlook profile.

o Select Join to Outlook Profile option.

o Select the desired Outlook Profile.



Saving Dplions

Marge PST
#Join PST  (Add each PST file a3 separate folder structure)
Join o nesw PST File Join to Office 365
Join to eadsting PST Fie Join to Exchangs Server

Join to Outleok: Profile

Ovtlook profie Outlaak -

o Click Join. 'Process completed' message is displayed after the process is completed

successfully. Click OK. The PST file will be saved at your specified location.

Note: In case of Join to new PST File, Join to existing PST File and Join to Outlook Profile, if the
size of the joined PST file exceeds the MS Outlook file size limit then the contents of the joined PST file

will split accordingly.

e Join to Office 365 : You can select this option when you want to join contents into Office 365

profile.

o Select Join to Office 365 option.
o Login by entering the Office 365 ID and Password.

Note: Make sure you have entered correct Office 365 ID and Password.



Saving Dplions

Marge PST
#Join PST  (Add each PST file a3 separate folder structure)
Join o nesw PST File Join to Office 365
S0 [0 exasting PET Fi= Join to in'.'dn;g ﬂrr.-'er

Join to Outleok: Profile

Connection Option

Office 365 1D sample Ssoftwarevisiblity, com

F'.ﬁ:'.r.l,':r_-_' BB RRRRREE

o Click Join. 'Process completed' message is displayed after the process is completed
successfully. Click OK. The PST file will be saved at your specified location.

Join to Exchange Server: You can select this option when you want to join the mailboxes
on Exchange Server.

o Select Join to Exchange Server option.

o From Exchange Connection Option select (either Administrator Domain or User
Domain).

o Enter Admin Email ID, Password, Mailbox Email ID and Server Name (for MS
Exchange 2007, 2010, 2013, 2016) and check the checkbox for Exchange Server
2010 or higher.



Exchange Connection Option
# Admirigtrator Domain

Uiser Domain
Adimin Email 1D administrator Sexample.com
Pasgword: BEERREERRES
Mailbooc Email 10: john@example.com
Server Mame; PC10

[ M5 Exchange Server 2010 or higher

ok [ caes

If you have selected User Domain option, then enter Admin Email ID, Password,
Mailbox Email Id and Server Name. Click OK.

Note: Make sure you have entered correct MS Exchange Server details.

Exchange Connection Option
Admirigtrator Domain %) User Domain
Mailbes Email ([D: | Jonn@example. com
Pazsword: sEEEBEREEES
Mailboo: Name: John Richards
Server Name: PC10

[ M5 Exchange Server 2010 or igher

[_ox ][ Cones

o Click Join. 'Process completed' message is displayed after the process is completed

successfully. Click OK. The PST file will be saved at your specified location.



View and Save Log Report

With Stellar Merge PST, you can save the Log Report to analyze the merging process at a later stage.

To save log report:

e From Logs Menu, select Log Report.

¢ Alog window appears on the screen displaying the details of the merged folders.

Product Mame ; Stellar Merge PST -
Process : Merge PST i
Destination Location @ C:\Users\Administrator, T5-D 10'\Desktop'StellarMergeP ST 2 1-Mov -2
Start Time : 21/11/2016 15:02

End Time : 21/11/2016 15:06

Source File » Ci\Users\Administrator, T5-D 10\Desktoptb.pst

Folder Mame : Deleted Items , Mail Count : 12

Folder Mame : Inbox , Mail Count : 40

Folder Mame : Sent , Mail Count ; 9

Source File : C:\Users\Administrator, TS-D 10'Desktopimac. pst

Folder Mame : Deleted Items , Mail Count : 14

Folder Mame : Inbox , Mail Count : 56

Folder Mame : meenu , Mail Count : 7

Folder Mame : anjul , Mail Count : 5

Folder Mame : Quthaox , Mail Count : 0

Folder Mame : Subscribed Public Folders , Mail Count @ 0

m

1 | ] [ 3

Save Clear Cancel

e Click Save button.
e In Save Log dialog box, click Browse and select the location where you want to save the log

report. Click OK.

To clear log report:

e From Logs Menu, select Log Report.
e Alog window appears on the screen displaying the details of the merged folders.

e Click Clear button.



FAQs
1. What does the demo version of the software do?
The demo version of the software allows you to see mail body and attachments only. Fields such as

From, To, CC, BCC, and Subject display 'Demo'. To view complete mailbox, you need to purchase
and register the software.

2. How can Stellar Merge PST help me search for the location of PST file in the computer?

You can search for PST file in a specific drive or folder using Find PST option of the software. For
more details, please refer Find PST Files topic of the help manual.

3. Which version of MS Outlook is supported by the software?

The software supports PST Files made with MS Outlook 2003, 2007, 2010, 2013, 2016.

4. How much time Stellar Merge PST software takes to merge/join PST mailbox?
The time for the merge/join process depends upon the size of PST file. While the process is running,

you have to wait for process to complete. Once the process is complete you can save the newly
created PST mailbox at the specified location.

5. Does the software merge password protected PST Files?

Yes, this tool is capable of merging PST files that are password protected. You need to enter the
password for that PST File.

6. Does the software maintain the integrity of the original PST files while merging them?

The software merges multiple Outlook PST files into a single file without modifying contents of the

original Outlook PST files.

7. Can we save process log?

Yes, Stellar Merge PST gives you option to save log report of the process.

To save log report:
e From Logs Menu, select Log Report.

e In Save Log dialog box, select the location where you want to save the log report. Click OK.



Legal Notices
Copyright

Stellar Merge PST software, accompanied user manual and documentation are copyright of Stellar
Information Technology Private Limited with all rights reserved. Under the copyright laws, this user
manual cannot be reproduced in any form without the prior written permission of Stellar Information
Technology Private Limited. No Patent Liability is assumed, however, with respect to the use of the

information contained herein.

Copyright © Stellar Information Technology Private Limited. All rights reserved.
Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject

to change without notice.

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH
REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY
EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR
INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES
INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS
OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND
THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED,
BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES,
WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION
WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE
THEREOF.

Trademarks

Stellar Merge PST® is a registered trademark of Stellar Information Technology Private Limited.

Windows Vista®, Windows 7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of
Microsoft® Corporation Inc.
All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their respective

companies.



License Agreement - Stellar Merge PST

Stellar Merge PST
Copyright © Stellar Information Technology Private Limited. INDIA

www.stellarinfo.com

All rights reserved.
All product names mentioned herein are the trademarks of their respective owners.

This license applies to the standard-licensed version of Stellar Merge PST.

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by Stellar Information Technology Private
Limited.

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or
use any copy of Stellar Merge PST with which this License is included, you may return the complete
package unused without requesting an activation key within 30 days after purchase for a full refund of

your payment.

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Stellar Merge PST. For purposes of this License, if you have a valid single-user license, you have the
right to use a single Licensed Copy of Stellar Merge PST. If you or your organization has a valid multi-
user license, then you or your organization has the right to use up to a number of Licensed Copies of
Stellar Merge PST equal to the number of copies indicated in the documents issued by Stellar when

granting the license.

Scope of License

Each Licensed Copy of Stellar Merge PST may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. This
is not a concurrent use license.

All rights of any kind in Stellar Merge PST, which are not expressly granted in this license, are entirely
and exclusively reserved to and by Stellar Information Technology Private Limited. You shall not rent,
lease, modify, translate, reverse engineer, decompile, disassemble or create derivative works based on
Stellar Merge PST nor permit anyone else to do so. You shall not make access to Stellar Merge PST
available to others in connection with a service bureau, application service provider or similar business

nor permit anyone else to do so.

Warranty Disclaimers and Liability Limitations


http://www.stellarinfo.com/

Stellar Merge PST and all accompanying software, files, data and materials are distributed and provided
AS IS and with no warranties of any kind, whether expressed or implied. You acknowledge that good data
processing procedure dictates that any program including Stellar Merge PST must be thoroughly tested
with non-critical data before there is any reliance on it and you hereby assume the entire risk of all use of
the copies of Stellar Merge PST covered by this License. This disclaimer of warranty constitutes an
essential part of this License. In addition, in no event does Stellar authorize you or anyone else to use
Stellar Merge PST in applications or systems where its failure to perform can reasonably be expected to
result in a significant physical injury or in loss of life. Any such use is entirely at your own risk and you

would not hold Stellar responsible for any and all claims or losses relating to such unauthorized use.

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special,
incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss
of business profits, business interruption, loss of business information, or any other pecuniary loss)
arising out of the use of or inability to use the software product or the provision of or failure to provide
support services, even if Stellar Information Technology Private Limited has been advised of the
possibility of such damages. In any case, Stellar Information Technology Private Limited’'s entire liability

under any provision shall be limited to the amount actually paid by you for the software product.

General

This License is the complete statement of the agreement between the parties on the subject matter and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the
State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries
of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any
violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or

future violation of the same provision or any other provision of this License.

Copyright © Stellar Information Technology Private Limited. All rights reserved.



About Stellar

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure
solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed,
global data recovery, data migration & erasure solutions provider with cost effective solutions available for
large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and

has a strong presence across USA, Europe & Asia.

Product line:
Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after accidental

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >>

File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS office repair

tools. More Info >>

E-mail Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook
Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail.

More Info >>

Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure

complete data protection against hard drive crash. More Info >>

Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives,
System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >>
Data Erasure

Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase
confidential data beyond the scope of data recovery. You can perform high speed bulk data erasure &

generate erasure certificates for audit trail purpose.

BitRaser supports 24 International data erasure standards. More Info >>


http://www.stellarinfo.com/disk-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/prevent-dataloss.php
http://www.stellarinfo.com/data-erasure/data-eraser-windows.php

For more information about us, please visit www.stellarinfo.com.
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